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[bookmark: _Toc23371512][bookmark: _Toc530990155][bookmark: _Toc30264][bookmark: _Toc41576554]Welcome 
Thank you for using CypOne laser cutting control Software! 
CypOne software is designed for fiber laser sheet cutting machine. It integrates functions of laser technique, parts nesting and CNC control etc. Main function features consist of drawing processing, parameter setup, process customizing, parts nesting, tool path planning and simulating, and cutting process controlling etc. 
CypOne has to work with control card to realize machining control. 
It will run as Demo mode in the computer without control card, while users still can operate most of the functions except machine control. You can modify drawing, edit toolpath and other designs on your laptop in the office, send file to machine for cutting. 
This manual only contains operation descriptions for CypOne main program, for CypOne config tool and other programs work with CypOne please refer to related manual or contact our support. 
The document is based on CypOne 6.1.723, there will be difference in later version-ups. 
If you have any question or advice in usage of our products, welcome to contact us by email support@fscut.com.
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The working and cutting performance of the machine are directly related to the material, laser, cutting gas, gas pressure and the parameters setup. Please be cautious in parameter setting! 
Improper parameter setting and operation may reduce the cutting performance, or even cause damage and injury to machine parts and human body. CypOne software has already designed multiple protections, meanwhile manufactures and users must follow the safety operation rules in case of any accidents and injuries. 

Shanghai Friendess Electronic Technology Corporation Limited does not bear any direct, indirect, incidental or corresponding losses and liabilities arising from the improper use of this manual or this product. 
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1. [bookmark: _Toc28810][bookmark: _Toc41576555]Quick Start 
[bookmark: _Toc23371514][bookmark: _Toc530990158][bookmark: _Toc498088404][bookmark: _Toc21746][bookmark: _Toc41576556]Function Features 
· Support AI, DXF, PLT, Gerber, LXD file format, and standard G code created by Master Cam, Type3, ARTCUT etc. 
· Optimize imported drawing automatically - delete duplicates, join lines, delete invisible and unnecessary figures of specified size, identify inner and outer contour and sort automatically etc., which all can be parametrically defined or manually done. 
· LED matrix function is designed for advertising decoration with LED lights that filling circles to part geometry in user defined pattern. 
· Divide function is to split large shape into small pieces fit for smaller machine bed. Split parts will be grouped and marked which let it recognizable for later picking up and putting together after cutting. 
· You can also measure curve length to estimate the material needed in later process. 
· Support common operations to zoom, translate, flip, rotate, align and duplicate object. 
· Support to add technique features including lead lines, kerf width compensation, micro joint tags, bridge and gap in a what-you-see-is-what-you-get style. 
· Automatically identify inner and outer contour, compensation direction and check the lead line. 
· Support to break and join line segments, smooth lines, combine and explode geometry etc. 
· Quick nest parts geometries into plate via a few clicks. 
· Flexible sorting functions. User can group the geometries to lock the cutting sequence. 
· Preview the cutting sequence statically or dynamically. 
· Quick set Fly Cut tool path. 
· Support flexible methods to execute piercing process, which allow users to group piercing sequence, select piercing stages and customize process by setting separate parameter group of laser, gas, delay and height etc. 
· Available to regulate laser power and pulse frequency in real time. 
· Allow user to save cutting technique of parameter group and reuse it to same material. 
· Capable to memorize interrupted cutting and resume from given position. Allow user to select part of the drawing for cutting. 
· Allow user to resume stopped/paused cutting from given position. 
· Powerful expansion capability with up to 30 PLC process and 50 programmable items. [footnoteRef:1] [1: This function requires password and executed by trained professionals. ] 

· Support to appoint and program input and output ports. 
· Support remote control via Ethernet by a wireless handle. 

[bookmark: _Toc23371515][bookmark: _Toc4946][bookmark: _Toc41576557]Access, Update and Install Software 
You can contact your supplier to get software or download directly on Friendess company website www.fscut.com. 
Please confirm your computer environment meets the following requirements: 
· Win7 and later operating system. 
· CPU I3 and above. 
· 4 GB memory at least. 
· VGA display above 15 inches, resolution 1280*1024 and above, 32-bit true color. 
· 2 USB ports at least. 
· If your operating system is based on Vista (including Windows Vista, Windows 7, Windows 8, Windows 2008 Server), run as administrator to avoid potential errors. 
Make sure running environment meets the requirements then install the software. Under Vista-based operating systems it's required to run as administrator. 
To avoid program files modified during installation and ensure all drivers installed properly, please close anti-virus software temporarily. 

[bookmark: _Toc23371516][bookmark: _Toc530990160][bookmark: _Toc9309][bookmark: _Toc41576558]Start Operation 
[bookmark: _Toc23371517][bookmark: _Toc8171][bookmark: _Toc41576559]1.3.1 Desktop Shortcut 
The shortcut icon [image: ]will appear on desktop after installation complete. Double click CypOne desktop icon to run the software. 
The below image will prompt during startup then enter into CypOne main interface. [image: ]

[bookmark: _Toc23371518][bookmark: _Toc10147][bookmark: _Toc41576560]1.3.2 User Interface 
[image: ]
The black area in main screen is drawing board, the white box is machine-scaled working zone. The grid on drawing board and ruler will scale up and down when zoom the view. 
On the top are Title bar and Menu bar. You can find most commonly used function buttons in menu bar, which are group-displayed in different tabs. There are[image: ], Home, and CNC tabs in menu bar, click each tab switch the function display. 
At very top on left is Quick Access Bar, where you can create, open or save the file, and undo or redo the operation. 
On Left Tool Bar listed basic drawing functions. The first five buttons are used to switch different edit mode, including select, node edit, sequence edit, drag and zoom. Click buttons of different shapes you can create geometry on drawing board. The last 3 buttons used to center align, explode geometry and fillet corner. 
On Layer Tool Bar on the right displayed a Layer button and the other 17 layer buttons of different color. Click Layer button will open 'Layer Parameter' window where users can setup most of the cutting parameters. Click color button to appoint a layer to selected part geometry, and this layer will by default used on next part geometry drew on drawing board. The part geometry appointed by the first layer [image: ]will be shown in white color as a 'background layer' and not be processed in a cutting task. The last two ‘First’ [image: ]and ‘Last’ [image: ]  layers indicate that to process the part geometry of ‘First’ layer at the very beginning and process the part geometry of ‘Last’ layer at very last. 
At the bottom is the information status bar. In 'Draw' window displays all messages of drawing operations. In 'System' window displays program messages apart from drawing operations. Each message printed with time tag and marked with different color so users can recognize these message as error, warning or notice etc. In 'Alarm' window displays all alarm messages in red color. 
The status bar at the very bottom will display message to different operation and mode. The 'Fine Tune' at bottom right is to move object by direction button in a precise distance. The rightmost shows control card model. 
On the right side is Control Panel where users execute most commonly used machining operations. From top to bottom are coordinate options, manual control buttons, machining control buttons, process options and production counter. 
[bookmark: _Toc498088409][bookmark: _Toc23371519][bookmark: _Toc530990163][bookmark: _Toc19969][bookmark: _Toc41576561]1.3.3 Menu Bar 
CypOne tool bar displayed in Ribbon style that groups options in different tabs to facilitate user operations. The picture below will help you understand: 
[image: ]
There are two tabs of Home and CNC, click each tab open the sub-menu. There will be a third tab 'Working' when machine in a cutting process. 
In each tab the options are arranged in different function column like 'View' and 'Transformation' etc. The buttons are large size for convenient operation. There might be small buttons like [image: ] under right corner of function column, click the button will open a dialog box. 
Click [image: ] under function button will open a drop-down list of more options. Click the button will execute the function immediately, click drop-down button will open option list. 
If you are Office 2007, Windows 7, or other ribbon-style programs user, you may already be familiar with this arrangement. Even you are first-time user will like the operation style. 
[bookmark: _Toc23371520][bookmark: _Toc23621][bookmark: _Toc41576562]1.3.4 File Menu 
At the top on menu bar is File menu with an icon button, click [image: ] to open the file menu which contained options about file operations. 
[image: ]
The file opened recently will be listed in file menu where you can find your last opened file easily. 
You can save the file as lxds format by 'Save As'. 
Click Import to add new drawing to drawing board and preserve the existing drawing. Click Open to leave current workspace and open a new file. 
You can setup options related with user habits in ‘User Settings’. Click 'Backup' will backup machine config, PLC and user config parameters into a compressed file. Click 'BCS100 Monitor' will open BCS100 monitor interface. 'Diagnostic Tool' used for monitor software state and troubleshoot. 
Click 'About' at bottom corner will prompt a window showing detailed CypOne software information. 
[bookmark: _Toc23371521][bookmark: _Toc530990165][bookmark: _Toc16269][bookmark: _Toc41576563]Operation Flow 
[bookmark: _Toc41576564][bookmark: _Toc498088412][bookmark: _Toc23371522][bookmark: _Toc530990166][bookmark: _Toc29930]1.4.1 Import Drawing 
[image: https://wdoc-75389.picgzc.qpic.cn/MTY4ODg1MzQ5OTAyNDg4Mw_501255_JYszBUQdECic9NvL_1588148624?imageView2]
Click  [image: ] on quick access bar will open the File dialog box, select the file you need to open. The preview window on the right side of the File dialog will list the files. 
[image: ]
You can also click [image: ]create new workspace and draw a part in CypOne with CAD tools. 
[bookmark: _Toc498088413][bookmark: _Toc530990167][bookmark: _Toc23371523][bookmark: _Toc23268][bookmark: _Toc41576565]1.4.2 Optimize Drawing 
CypOne will automatically optimize the imported drawing - delete the duplicates and invisible shapes, join lines, smooth lines, sort and explode groups etc. You can also customize the optimize features in File > User Settings > User Configuration. 
Normally, the geometry figures in drawing should be of closed contour. Otherwise the software will highlight the open figures in red color. This function can be turned off. You can check open figures in Home > View drop down menu by [image: ] and [image: ] option. You can also select open figures by clicking Select > Select Open. 
You can break lines by Home > Optimize > Break Line, then click on the line where need to break. And join the lines by Optimize > Join Line. 
[bookmark: _Toc23371524][bookmark: _Toc530990168][bookmark: _Toc498088414][bookmark: _Toc27573][bookmark: _Toc41576566]1.4.3 Technique Setting 
The functions under Home > Technique parameter column are the most frequently used options in machining process. Click [image: ] set lead lines, click [image: ] set the over-cut, gap or seal features. Click [image: ] to add kerf width compensation. Click [image: ] add micro-joint tags which prevent parts from falling off the plate skeleton or tip-up collision with laser head. Click [image: ] reverse the contour (cutting) direction. Click [image: ] and point on geometry to set start point. Or you can point outside the contour to create a lead line to the part. 
You can press Ctrl + A select all drawings, then click ' ' to set lead lines by user defined settings. Click Lead drop-down > Check Lead Line, program will check if lead lines interfere with parts design and modify the lead line automatically. 
Click button [image: ] on layer tool bar to set the detailed cutting parameters. The Layer Parameters dialog box contains almost all the parameters related to the cutting performance. 
[bookmark: _Toc498088415][bookmark: _Toc530990169][bookmark: _Toc23371525][bookmark: _Toc12853][bookmark: _Toc41576567]1.4.4 Toolpath Planning 
This process is to sort parts geometry and create cutting sequence. Click [image: ]on Home > Sort will sort all geometries automatically. Or you can select in Sort drop down menu that fit your drawing layout. The software can identify the inner/outer relation in sorting. 
You can click [image: ] on left toolbar to manually modify the sequence. Click one geometry and click next will define the cutting sequence between these two geometries. 
You can click [image: ] group the sorted geometries to lock the sequence inside the group. The geometries inside this group won't be affected in other sorting process. 
Right click the group open dialog box, select 'sort in group' to modify the sequence inside the group. 
[bookmark: _Toc530990170][bookmark: _Toc498088416][bookmark: _Toc23371526][bookmark: _Toc28745][bookmark: _Toc41576568]1.4.5 Pre-Check 
Users can check the tool path in several ways before start cutting on machine. Slide the process bar to skim the sequence or click ' ' to check the sequence one by one. 
[image: ]
Click [image: ] button on control panel or [image: ] in CNC tab will simulate the tool path in software. Users can adjust simulation speed click [image: ] and [image: ] in CNC tab. 
[bookmark: _Toc530990171][bookmark: _Toc23371527][bookmark: _Toc498088417][bookmark: _Toc19460][bookmark: _Toc41576569]1.4.6 Cutting Control 
Please take notice that it requires machine with compatible control card to realize cutting control. 
Before start cutting you have to check relative position between drawing and machine bed. Click [image: ] on control panel you can see the relative position between cutting zone and machine bed. This relative position is calculated by part zero and laser head location. There are some symbols on the screen, click [image: ]the Zero reference mark will move to the laser head position. 
[image: ]
If the red cross mark does not match the real position of laser head, please check the mechanic origin and correct the origin by CNC > Return Origin. If click [image: ] on control panel, the drawing crossed white box on screen, it indicates the cutting zone will exceed machine bed. 
If the red cross does not match the real position of laser head, please check the mechanic origin and correct the origin by CNC > Return Origin. If click ' ' the drawing crossed white box on screen, it indicates the cutting zone will exceed machine bed. 
Click [image: ] in Home tab will change the part zero and relative position between cutting zone and machine bed. For example, if laser head located at left corner to workpiece, you should select Zero Ref at left bottom. 
If drawing placement fit in white box, click [image: ] in control panel, machine will dry run along the border of the cutting zone. You can also click [image: ] machine will dry run along tool path. 
Click [image: ] start machining, Click [image: ] pause the process and you can manual control laser head up and down, open or close laser and gas etc. In pause status users can click [image: ] and [image: ] to move laser forward or backward along tool path. Click [image: ] or [image: ]resume the machining process. 
Click [image: ] end the machining process. Laser head will return to the pre-set position. If you didn't change drawing or start new cutting, click [image: ]can locate to interrupted position of last cutting process, click [image: ] resume cutting. 

2. [bookmark: _Toc530990172][bookmark: _Toc23371528][bookmark: _Toc22238][bookmark: _Toc41576570]CAD Operations 
[bookmark: _Toc530990173][bookmark: _Toc23371529][bookmark: _Toc31839][bookmark: _Toc41576571]Features Display 
In Home > View provides various options to display technique and geometry features of drawing: 
[image: ]
Click the option you can see feature tags applied on drawing immediately. The option button in yellow indicates the option activated. If the option button not in yellow color means function not enabled. For example, [image: ] is enabled, graphic will show the tool path with arrow symbol, close [image: ]the arrow symbol disappear. 
Click [image: ] the drawing will display in center of white box. 
Click small icon [image: ] below View will open user configuration dialog box where you can customize more detailed effect like snap and ruler etc. 
Scroll the mouse to zoom the view. Click F3 will center drawing in white box, click F4 will center the white box in drawing board. Or you can do same operations by right click and open dialog box, select zoom > options. 

[bookmark: _Toc23371530][bookmark: _Toc6425][bookmark: _Toc41576572]Selection 
CypOne provides various ways to select objects on drawing board. The basic operation is 'Click', click on drawing to select object. Another commonly used operation is 'frame selection', drag the cursor on the screen will create a frame box to select object. There are 2 patterns of frame selection: drag from left to right will create a blue box, only when a whole part was framed in the box will be selected. Drag from right to left will create a green box, as long as part of the geometry was framed in the box, the whole object will be selected. 
The 'frame selection' effect of these 2 patterns shown below. In left picture is effect of drag from left to right that only BC will be selected, in right picture is effect of drag from right to left that ABCD will all be selected. This selection method makes it flexible to select object. 
[image: ][image: ]
Press Shift when select object you can select or deselect new object without changing existing selections. 
Common operations: Select all (Ctrl + A), Invert selection, Copy (Ctrl + C), Paste (Ctrl + V), Cut (Ctrl + X), Deselect, Copy with base point. 
· Geometric operations: Select open, select similar, select all outer/inner contour, or select objects smaller than specified. 
· Layer operations: select a layer, lock background layer. 
· Click 'forbid fast drag-copy' will not allow user drag any shape in drawing board or duplicate object by ctrl + left click operation. 
'Select similar' is to select all objects of same shape and size with specified one. For example, select a circle of 5mm radius, then click 'select similar' will select all circles of 5mm radius on drawing board. 

[bookmark: _Toc530990175][bookmark: _Toc498088421][bookmark: _Toc23371531][bookmark: _Toc15590][bookmark: _Toc41576573]Geometric Transform 
In Home > Transformation column provides options to modify geometry. Select a function option then select an object on drawing board to apply the effect like flip, rotate or align etc. 
[bookmark: _Toc23371532][bookmark: _Toc530990176][bookmark: _Toc16003][bookmark: _Toc41576574]2.3.1 Size Modification 
[image: ]CypOne provides 7 options under ‘Scale’ drop down menu to quick modify the geometry size. Pictured as right: 
For example, '100mm' will scale the object with the size of 100mm, '2 times' will enlarge the object 2 times larger. 
Click Scale button will open dialog box to change geometry in precise size, input new size and click OK. 
[image: ]
If the lock icon in this state[image: ], the scale of length and width is coupled, if you want to modify the length and width separately click the icon [image: ]turns to this state [image: ] will unlock the linkage of two size input.
‘Scale center’ specifies the relative position between new geometry and the original one. For example, ‘Top left’ indicates the object in new size will locate at the top left of the original one. 
Notice: The lead line and kerf compensation will not change with new sized geometry. 
[bookmark: _Toc23371533][bookmark: _Toc498088423][bookmark: _Toc530990177][bookmark: _Toc8662][bookmark: _Toc41576575]2.3.2 Dynamic Transform 
In CypOne you can transform geometry by scale, rotate and flip. Select the geometry on drawing board then click option button to finish the geometry transform. 
For example, to rotate a rectangle 45° in the base line of left bottom, you can follow the steps: 
1) Select the object. 
2) Click Home > Transform > Rotate, in bottom information bar will prompt guide message ‘please specify basepoint: ’ 
3) Click left bottom of the object it will snap to key point: 
[image: ]
4) Click again in bottom information bar will prompt guide message ‘input rotation angle: ’
5) Input 45 and click Enter will finish the operation. 
If you want to rotate the rectangle and align with another object, then follow the below steps: 
6) Click the right corner of rectangle will create a rotation base line. 
7) In bottom window prompts 'specify end point of rotation:  ‘Move the base line snap to key point and click. As below: 
[image: ]
Dynamic scale and flip operation much like the rotation, there will be no more description here. 
[bookmark: _Toc498088424][bookmark: _Toc23371534][bookmark: _Toc530990178][bookmark: _Toc29135][bookmark: _Toc41576576]2.3.3 Translate and Copy 
You can quick translate the geometry with direction button. Click [image: ]button at bottom bar into activate status [image: ] and input a distance. Select object and click direction button will translate the object in preset distance. It allows you to move geometry in precise distance then return it back to original position. Press Ctrl and direction key will duplicate selected geometry. For example, press Ctrl and right direction button, will create a duplication at right side 100mm to selected object. 
[bookmark: _Toc498088425][bookmark: _Toc23371535][bookmark: _Toc530990179][bookmark: _Toc15548][bookmark: _Toc41576577]Parameter Input 
In some cases, it requires coordinate position in drawing geometry. CypOne allows user to locate position by input a coordinate, for example, (100, 100) input as 100,100. Coordinates and parameters are shown in blue. 
Most of the drawing operations allow both mouse operation and parameter input method. The following steps show you how to draw a rounded rectangle of length 300mm, width 200, with fillet radius 25mm. 
1) Click [image: ] select [image: ]at left toolbar, meanwhile bottom window will prompt 'Please specify start point'. 
2) Input ‘0, 0’ press enter, then prompt' please specify cross point'. 
3) Input '300,200' press enter, prompt' please specify radius'. 
4) Input 50 press enter. All operations are completed. As shown below. 
[image: ]
[bookmark: _Toc23371536][bookmark: _Toc498088426][bookmark: _Toc530990180][bookmark: _Toc29017][bookmark: _Toc41576578]Snap 
CypOne will activate ‘snap to key point’ like grid or geometry border in some operation. 
You can turn off the snap function in [image: ] > User Settings > User Configuration > Drawing board, deselect [image: ]option. The snap precision can be set in same dialog box. 
[bookmark: _Toc23371537][bookmark: _Toc530990181][bookmark: _Toc385][bookmark: _Toc41576579]Draw 
CypOne provides CAD tools on left tool bar, from top to bottom are: point, line, polyline, circle, arc, rectangle, polygon and text. Drawing operations are similar with CAD. 
[bookmark: _Toc23371538][bookmark: _Toc15485][bookmark: _Toc41576580]2.6.1 Standard Shape 
Drawing shapes of circle, rectangle and other is quiet simple. There will be no more descriptions here. There are two special options in Circle menu: 'Replace circle as point' and 'Replace by circle'. The former one can replace circle as point, the later one can replace selected object as circle. 
In Polygon menu provided rectangle, rounded rectangle, polygon and star shape. To draw a rounded rectangle, you need to draw a rectangle then specify the round corner radius. To draw a polygon or star shape, you have to specify the edge numbers (from 3 to 100). Edge number also indicates star tips. 
[bookmark: _Toc23371539][bookmark: _Toc10461][bookmark: _Toc41576581]2.6.2 Text 
Text can be transferred to curve in CypOne. Click [image: ] on left tool bar then type in text on target position.
On top menu bar will display Text tab and options where you can modify content, size and style of text. As below: 
[image: ]
The content and style of text cannot be changed once it's transferred to curve. After you finish all design and settings of the text, transfer the text to curve as last step. 

[bookmark: _Toc23371540][bookmark: _Toc530990185][bookmark: _Toc11443][bookmark: _Toc41576582]Measure 
Measure tool is to measure the distance between two points. 
Click [image: ] in Home > Tools and point two points on drawing board, the distance between points will display in bottom window. 
[image: ]
[bookmark: _Toc23371541][bookmark: _Toc530990186][bookmark: _Toc498088428][bookmark: _Toc9088][bookmark: _Toc41576583]Optimize 
CypOne will optimize the imported drawing. You can also modify the drawing by Home > Optimize options: 
[image: ]
Select a part geometry and click optimize option then finish the operation by prompted guider. 
[bookmark: _Toc23371542][bookmark: _Toc24732][bookmark: _Toc41576584]2.8.1 Smooth Line 
Select a geometry and click 'Smooth Line' will open dialog box, input smooth precision click OK will apply to selected object immediately.   
The comparison between original and smoothed geometry shown below. The example here put a large value of precision to make comparison visible, user has to input precision value as needed. 
[image: ]
[bookmark: _Toc23371543][bookmark: _Toc2931][bookmark: _Toc41576585]2.8.2 Break Line 
‘Break Line’ is to break a closed geometry or open figure into segments. Click 'Break Line ' and point on geometry. Break function will keep functioning until switch to other command or press ECS turn off the function. 
[bookmark: _Toc23371544][bookmark: _Toc498088431][bookmark: _Toc530990189][bookmark: _Toc20574][bookmark: _Toc41576586]2.8.3 Delete Invisible 
There are unneeded geometries too small and invisible in a drawing that will cause laser head located to a strange position in cutting. Click in Home > Optimize > Delete Invisible, then define the size of the shapes to be deleted. The shapes smaller than specified size will be deleted while others preserved. 
[bookmark: _Toc498088432][bookmark: _Toc23371545][bookmark: _Toc530990190][bookmark: _Toc11640][bookmark: _Toc41576587]2.8.4 Delete Duplicate 
Lines of geometry lying together make it visually look like one line which cause unnecessary and repeated cutting damage the workpiece. Click 'Delete Duplicate ' will delete the duplicates by given tolerance. 
[bookmark: _Toc23371546][bookmark: _Toc498088433][bookmark: _Toc530990191][bookmark: _Toc24072][bookmark: _Toc41576588]2.8.5 Join Line 
There are lines visually connected but not joined and hard to identify even zoom close. Select geometries and click 'Join Line' can join all line segments within given tolerance. 
[image: ]
In some cases you have to delete unnecessary lines then join line segments. 
[bookmark: _Toc23371547][bookmark: _Toc498088434][bookmark: _Toc530990192][bookmark: _Toc21107][bookmark: _Toc41576589]2.8.6 Break Grid 
This function used to cut large in-part waste into small pieces falling down to prevent tip-up collision. The cutting line shown in white color. 
[image: https://wdoc-75389.picgzc.qpic.cn/MTY4ODg1MzQ5OTAyNDg4Mw_222876_08oTzRRRYfepxVCS_1589599909?imageView2]
[bookmark: _Toc23371548][bookmark: _Toc2506]View 
[image: ]You can zoom and adjust view, edit drawing or modify sequence in this module. Function entry is on the top of the left toolbar. From top to bottom is select, node edit, manual sort, hand tool and zoom. 
[bookmark: _Toc530990195][bookmark: _Toc23371549][bookmark: _Toc41576590][bookmark: _Toc28970]2.9.1 Node Edit 
You can adjust the drawing precisely by node editing. Click [image: ] then select geometry you can see nodes on drawing. Drag the node to adjust the drawing. Click [image: ] again will disable the function.
[image: ]
Nodes in blue and yellow both are editable. 

3. [bookmark: _Toc498088435][bookmark: _Toc23371550][bookmark: _Toc530990196][bookmark: _Toc29004][bookmark: _Toc41576591]Technique Setting and Tools 
The chapter describes the techniques in laser cutting. You have to set the cutting technique fit your cutting condition considering that the actual cutting performance directly related with material, laser and gas etc. All parameters should be considered as reference not a guide value. 
Improper or incorrect parameters may result in bad cutting performance even damage the machine. 

[bookmark: _Toc23371551][bookmark: _Toc29395][bookmark: _Toc41576592]Lead Line 
[bookmark: _Toc498088437][bookmark: _Toc530990198][bookmark: _Toc23371552][bookmark: _Toc14955][bookmark: _Toc41576593]3.1.1 Inner & Outer Contour 
CypOne can identify the inner and outer contour of part geometry automatically. After modify the part geometry the inner/outer relations will change, click [image: ] in ‘Sort’ drop down menu will identify the inner/outer relation of changed part geometries. 
The principle to identify the inner/outer relations in CypOne works like this: the outmost contour is outer contour and next to it is inner contour, open figure not considered in. If you want to specify an outer contour within a part geometry, group all shapes inside this contour and set sequence within this group. 
Lead line introduce to part from outside outer contour, inside from inner contour. Select a contour and click [image: ] and [image: ] to change contour relation. 
[bookmark: _Toc23371553][bookmark: _Toc498088438][bookmark: _Toc530990199][bookmark: _Toc18763][bookmark: _Toc41576594]3.1.2 Auto Lead Line 
Select objects and click [image: ] in Home tab open the dialog box like below: 
[image: ]
There are three styles of lead line including line, arc, arc + line, each style is available to define the lead length and lead angle. It's also available to add small circle on lead line. 
The front end of arc style lead line is always tangent to part geometry. The lead angle of arc is the angle between part geometry and the line connected two ends of arc. Lead out line of arc style is similar with this principle. 
[image: ]
If you select lead position will change lead position and type of previous lead line. You can select [image: ] to preserve the lead position of preset lead line. 
[bookmark: _Toc23371554][bookmark: _Toc530990200][bookmark: _Toc498088439][bookmark: _Toc19744][bookmark: _Toc41576595]3.1.3 Manual Lead Line 
Click [image: ] to manually change lead line. Click on part geometry will change lead position while maintain the length and angle.
[image: ]
Or you can create a lead line by[image: ]. Click and drag a line to part geometry will create a lead line. 
[image: ]
[bookmark: _Toc23371555][bookmark: _Toc530990201][bookmark: _Toc498088440][bookmark: _Toc19447][bookmark: _Toc41576596]3.1.4 Check Lead Line 
Click ‘Check Lead Line’ under ‘Lead’ drop down menu software will check lead line interference with part geometry and modify the length automatically. Click 'Identify inner/outer contour' software will adjust lead line direction by identified contour relation. 
[bookmark: _Toc23371556][bookmark: _Toc530990202][bookmark: _Toc498088441][bookmark: _Toc7519][bookmark: _Toc41576597]3.1.5 Over, Gap and Seal 
There are four options under [image: ] drop down menu[image: ]. Select part geometry and click option to add features. 'Gap/Over' setting only take effect to selected objects, the previous setting of other object doesn't change. 

[bookmark: _Toc498088442][bookmark: _Toc530990203][bookmark: _Toc23371557][bookmark: _Toc14479][bookmark: _Toc41576598]Compensate 
Select part geometry and click [image: ] open dialog box. 
Kerf width compensation accessed by measuring and comparing cutted part and part design. The new path of compensation is white color and machine will follow the compensated tool path. Origin contour of part geometry still preserved on drawing board for comparison. 
The compensation is inside or outside (expand or shrink) part shape identified by inner/outer contour relation, also user can select options. 
You can select to round the corner of compensated tool path. 
[image: ]
In the image, the white line is compensated tool path, yellow line vertical to compensated path. The compensated corner is rounded. The rounded corner can guarantee smooth cutting. 
Click [image: ] drop down list to edit and save commonly used kerf width options. 
You can choose if to compensate open shapes or preserve original toolpath. 
Select objects you want to delete compensation then click [image: ] will delete the compensated path. 

[bookmark: _Toc530990204][bookmark: _Toc23371558][bookmark: _Toc498088443][bookmark: _Toc3376][bookmark: _Toc41576599]Micro Joint 
Micro joint is a gap of small distance on part geometry, the gap won't be cut in process and keep part attached to plate skeleton, which can avoid tip-up collision. The laser doesn't fire in the path of micro-joint. Micro joint featured as a gap on part geometry on drawing board. 
[image: ]
Click [image: ]open dialog box set the length, click on part geometry will apply micro joint feature, and you can apply this feature multiple times until press Esc cancel the command. Micro joint can apply to compensated path. 
Apart from add micro joint one by one on part geometry, you can apply automatically by parameter setting. Click [image: ] in drop down menu open dialog box. There are two patterns of adding micro joint: by total number or by interval. For example, you can choose to add 10 micro joints to each figure, or add micro joint to part geometry every 100mm interval. 
Click [image: ] in drop down menu will break micro joint from tool path. Exploded micro joint is editable and available to add lead line as individual figure. 
To delete micro joint, select the objects and click [image: ] in 'Clear ' drop down menu. Or activate micro joint function press Shift button and click on micro joint tag can also delete it. 

[bookmark: _Toc23371559][bookmark: _Toc24428][bookmark: _Toc41576600]Fillet 
Click [image: ] then point on part corner will round sharp corner by preset radius. Select part geometries then click [image: ] left tool bar can add fillet to all selected objects. 
[image: ]

[bookmark: _Toc498088445][bookmark: _Toc23371560][bookmark: _Toc530990208][bookmark: _Toc28753][bookmark: _Toc41576601]Group 
If you 'Group' multiple geometries, the group will be identified as one object. The sequence and layer inside group will be locked and won't be changed when you drag or sort part. 
Select the geometries and click [image: ]can create a group. Select group and click [image: ] will explode group into individual shapes. Click [image: ]in drop down menu will explode all groups on drawing board. 
[image: ]Only explodes group into individual shapes, it will not break lines of closed geometry. [image: ]will explode shapes and lines into segments.
The shape contains all other shapes in a group will be identified as the outer contour of a part. 
Users have to group shapes by the logic of part geometry, which means only the shapes consist of a part should be grouped together. The terms 'group' and 'part' in CypOne indicates same meaning most of time. 
CypOne will group the common line geometries automatically for its integrity. The geometries applied 'Bridge' also be grouped automatically. 
[bookmark: _Toc23371561][bookmark: _Toc32520][bookmark: _Toc41576602]3.5.1 Sort in Group 
A group in sorting process is identified as one single object, the sequence of shapes inside a group will not change. 
If you want to modify sequence of shapes inside group without explode it, right click group and select 'Sort in group'. 
There might be group inside a group, 'sort in group' will not change the sequence of shapes in sub-group inside a group. The sorting approach inside a group only relates with geometric relations not to do with layer of shapes. 
[bookmark: _Toc23371562][bookmark: _Toc17951][bookmark: _Toc41576603]3.5.2 Process of Group 
Group will be identified as an independent object, until a group finished cutting it will not move on to the next part drawing. Piercing process to a group also follows the same rule. 
Please notice that the outer contour of part design should always cut at last, sort the part design set proper sequence before cutting. 

[bookmark: _Toc498088448][bookmark: _Toc530990211][bookmark: _Toc23371563][bookmark: _Toc12504][bookmark: _Toc41576604]Fly Cut 
For parts of regular shape arranged in array pattern, apply Fly Cut can profoundly improve cutting efficiency. Fly Cut is a high-speed cutting technology. Laser head performs the cutting without interruption at a continuous speed which makes it looks like floating on sheet. 
Sort the part geometries then create fly cut path can optimize fly cut path. 
Click [image: ] in Home tab open dialog box. If selected geometries are circles, dialog box would be 'Circular fly cut' otherwise it's 'Linear fly cut'.
Start position defines where to start fly cut. Joint interval is that when fly cut path make a turn, when interval to next row of shapes smaller than this distance can be connected. Allowed space is that when space between two objects longer than this value won't create fly cut path between them. 
[image: ]
[image: ]
When all geometries are circles, select 'circular fly cut' open dialog box setting parameters. 
Allowed space means that when space between two circles larger than this it won't create fly cut path. 
Click 'Sort' software will sort part geometries first then create fly cut tool path. Click 'Cut by part' the toolpath will follow the principle of finish cutting of a whole part then start next. 
[image: ]

[image: ]	There is a parameter ‘FlyCut overcut’ in ‘Global Parameter’ window to add extra cutting at the end of each part to make sure parts are fully cut off.

[bookmark: _Toc530990212][bookmark: _Toc23371564][bookmark: _Toc498088449][bookmark: _Toc9117][bookmark: _Toc41576605]Co-edge 
[image: ]Merge the shared line of two parts as one will reduce the total cutting length and improve efficiency. In CypOne, the geometry borders between which gaps smaller than 1 mm can merge as common line. Drag a shape close to another one, it will snap to the geometry border. 
Select the objects and click [image: ] to create common line. 
Curve shape cannot create common line in CypOne. 
The geometries merged common lines will be integrated as a group. If the part design has in-part geometries, group the shapes within this part then make common line, otherwise software cannot identify geometry relations and sequence. 
[bookmark: _Toc23371565][bookmark: _Toc6574][bookmark: _Toc498088450][bookmark: _Toc530990213][image: ]3.7.1 Auto Snap in Co-edge 
When drag a part geometry close to another in CypOne, it will snap to key points or border in tolerance range. Snap can help to place two geometries together in common line application. Snap also works for multiple geometries drag together. 
Once two geometries share the border, click [image: ] will merge the shared edge as common line. If you want to edit geometries applied common line, click [image: ] under ‘Group’ drop down list to explode common line geometry. After modify the individual shapes then group them again. 
[bookmark: _Toc23371566][bookmark: _Toc22220][bookmark: _Toc41576606]3.7.2 Co-edge with Compensation 
If you want apply kerf compensation to common line geometry, compensate before co-edge the geometries. Co-edge won't change geometric shape in merging common line. If the part geometry applied kerf width compensation, only compensated path will be left on drawing board after co-edge. 
[image: ]
For example, in above image, A is original design, P is compensated path to A, it's P and B co-edged as common line. Even if move B close to A still cannot co-edge, because A is not tool path anymore. 

[bookmark: _Toc498088452][bookmark: _Toc530990215][bookmark: _Toc23371567][bookmark: _Toc25137][bookmark: _Toc41576607]Bridge 
Bridge usually applied to connect the parts with separate figures, usually used in text character cutting. The part geometries connected by bridge also reduce the piercing times. You can apply bridge on part design multiple times to connect separate shapes. 
Click [image: ] open dialog box, set the parameters and drag a line between shapes you want to connect. Like below: 
[image: ]
There are two options to define bridge- effective distance and bridge width. The former one decides that only between lines of distance within this value can apply bridge, the later one decides width of bridge. 
Please take notice that separate geometries connected by bridge will have a continuous cutting which can be affected by thermal distortion. 
[bookmark: _Toc498088456][bookmark: _Toc530990216][bookmark: _Toc23371568][bookmark: _Toc21941][bookmark: _Toc41576608]Array 
This function can create duplications in a user defined array. 
[bookmark: _Toc23371569][bookmark: _Toc24639][bookmark: _Toc41576609]3.9.1 Rectangular Array 
Click [image: ] or [image: ]under Array drop down menu will open the dialog box: 

[image: ]
Set the row and column numbers and other options click OK will create duplication in defined array. 
[image: C:\Users\FSCUT\Desktop\说明书相关\说明书图片\阵列1.bmp]
[bookmark: _Toc23371570][bookmark: _Toc24276][bookmark: _Toc41576610]3.9.2 Dynamic Array 
Click [image: ] open the dialog box, setup the interval of rows and columns, then drag an area to create duplications. Like below: 
[image: C:\Users\FSCUT\Desktop\说明书相关\说明书图片\交互式阵列.bmp]
[bookmark: _Toc498088461][bookmark: _Toc530990221][bookmark: _Toc23371571][bookmark: _Toc24622][bookmark: _Toc41576611]Batch Modify 
You can apply changes of one geometry to similar geometries by batch modify to improve efficiency, take an example: 
Select a geometry and enter in batch modify window, set lead line, the changes will apply to all similar geometries of same shape and size. 
[image: ]
[image: ]
[image: ]
[bookmark: _Toc23371572][bookmark: _Toc7619][bookmark: _Toc41576612]LED Matrix 
LED Matrix used to fill circles inside geometry by user defined style. Fabricators in advertising industry need to cut circles on workpiece put LED lights. CypOne provides easy ways to design these circles on part geometry. 
[bookmark: _Toc23371573][bookmark: _Toc13641][bookmark: _Toc41576613]3.11.1 LED Matrix Filler 
LED matrix filler can apply to all closed shapes. Select a shape and click [image: ] in Home tab open the following dialog box. 
[image: ]
The radius defines circles size, margin means the gap between border and outmost circles. There are 5 style options to create circles layout pattern. 
[bookmark: _Toc23371574][bookmark: _Toc32344][bookmark: _Toc41576614]3.11.2 LED Matrix Tool 
LED Matrix Tool used to adjust layout of filled circles. Click [image: ] in LED Matrix drop down menu will open dialog box. 
[image: ]
Set the circles interval distance and margin then click[image: ], drag an area on drawing will apply changes to circles inside selected area. Click [image: ] then drag an area on circles will delete the circles in this area (only apply to circles made by LED Matrix). [image: ] is to check the circles number and layout within a selected area. 
[bookmark: _Toc23371575][bookmark: _Toc13051][bookmark: _Toc41576615]3.11.3 Divide 
The advertising decoration can be larger than machine bed in size of meters, fabricator has to divide whole drawing design into smaller shapes fit to cut in machine then put cutted pieces together. 
Click [image: ] open dialog box. Mark is to add mark of number and letters at divide end make it recognizable to pick up and put together cutted pieces. The mark will be appointed as marking layer. Select [image: ] will group the divided shapes in case of messing up the design. 
[image: ]  [image: ]
[bookmark: _Toc23371576][bookmark: _Toc27024][bookmark: _Toc41576616]3.11.4 Curve Measure 
Click function button and define a curve segment by appoint start and end point. The curve highlighted in yellow is to be measured, the length result will be shown in bottom Draw window. 
[image: ][image: ]

[bookmark: _Toc498088462][bookmark: _Toc530990222][bookmark: _Toc23371577][bookmark: _Toc31876][bookmark: _Toc41576617]Technique Parameter 
There are 16 layers in CypOne, users can set the cutting parameters to each layer including cutting speed, laser power, gas pressure and nozzle height etc. The last two layers are 'First' and 'Last' which means to process at very first and at very last in sequence. 
Click [image: ] in Home tab or [image: ] aside control panel will open 'layer parameter' dialog window contains all cutting parameters. The first tab 'Global parameter' listed motion control parameter, laser burst parameter, default gas blow parameter and follow actions parameter etc. In all layer tabs listed cutting and piercing parameter groups, click and open each layer tab set parameter separately.
[image: ]
Notice: In 'Layer Parameter' dialog window will display different parameters by laser and gas configuration. The parameter in demonstration image is only for reference. 
[bookmark: _Toc23371578][bookmark: _Toc17152][bookmark: _Toc41576618]3.12.1 Parameter Description 
The following table gives a brief description to some of the layer parameters. 
	① Basic parameters 

	Cut speed 
	The target/command cutting speed, while the actual cutting speed is under this value considering the speed change in corner turning, or in start and end phase in a tool path segment. 

	Lift height 
	After finish a tool path segment, laser head lifts and locates to next start point of tool path segment. When pause the cutting, laser head also lifts and holds to this height. 

	②Cutting parameters 

	Nozzle height 
	The standoff distance between nozzle and plate surface in cutting. 

	Gas type 
	Gas type in cutting. 

	Gas pressure 
	Gas pressure in cutting. Pressure regulation requires DA gas valve signal given by CypOne. 

	Peak power 
	The peak power decides the maximum power in cutting. Take an example,3000W laser source, peak power set by 80%, the maximum power in cutting is 3000 * 80% =2400W. 

	Duty cycle 
	The duty cycle of PWM laser modulation signal in cutting. 3000W laser, peak power 80%, duty cycle 80%, the average cutting power is 3000*80%*80%=1920W. 

	Pulse frequency 
	The pulse frequency of PWM modulation signal, it defines laser fire times in one second, higher frequency indicates more continuous laser wave. 

	Focus position 
	The relative position between laser focus to nozzle tip. 

	Laser on delay 
	The laser fires duration before start cutting to burn through a small hole on material. 

	Step time 
	The time spent that lower from pierce height to cut height. 

	Laser off delay 
	The delay to turn laser off to make sure cutting totally finished. 

	Extra blow 
	The extra gas blow after pierce finished and laser turns off to cool down the material. 

	③ Other parameters 

	Not cut 
	The parts drawing of this layer doesn't cut. 

	Not follow 
	Laser head holding in fixed height in cutting, now to follow a constant distance with plate surface. 

	Gas on 
	Gas is open in the whole machining process. 

	Reduce lift 
	This function has to work with another parameter 'Unlift when travel shorter than' in global parameter. When finish a toolpath segment, if the travel distance to next start point shorter than this value, laser head doesn't lift and move directly to next start point. 

	Pre-pierce 
	Finish all pierces at start point then start cutting. There is 'auto group pre-pierce' option in global parameter dialog box. Note: this option cannot work with defilm together 

	Defilm 
	Execute defilm cutting along toolpath first, then start cutting. Enable this function will open a parameter window for setting defilm parameters. 

	④Slow start 

	Lead length 
	This used in cutting thick material, it will start cutting in a slow speed to make sure plate cut through. 

	Lead speed 
	The speed in this slow start length. 

	⑤ Power curve 

	Laser Power/Frequency Regulation 
	After you enable this function you can edit the power/frequency curve, and program will regulate the laser power and frequency according the curve. This function is very practicable improving corner precision. Notice: Frequency regulation curve must be used with power regulation curve. 



[bookmark: _Toc23371579][bookmark: _Toc18225][bookmark: _Toc41576619]3.12.2 Laser Power/Frequency Regulation 
If enabled[image: ] [image: ], CypOne will regulate laser frequency and duty cycle in real time by speed change by preset curve scale. Click [image: ] to edit power/frequency regulation curve. 
[image: ]
In above image, horizontal axis is cut speed, vertical axis is laser power/pulse frequency, and the unit is percentage %. You can click on curve to add nodes or copy the power-speed scale curve to pulse frequency- speed scale. When cut speed reaches to one point in horizontal axis of scale curve, laser power and pulse frequency will be regulated in real time coincidence to the vertical axis of scale curve. Notice: Pulse frequency curve must works with power curve, means you have to enable both scale curve. 
For example, laser power 500W, preset cut speed 100mm/s, peak power 90%, cut power (duty cycle) 80%, when the real cut speed lower to 60% of target cut speed, CypOne will regulate laser to: 
500W X 90% X 80% X 60.00% = 216.0W 
The power will not be lower than 10% of the laser power, for example 500W laser will not lower than 500*10%=50W. 
If not select[image: ]  [image: ], the cut power will remain same in cutting process. In the above example, the power in the cutting process remains 500 W X 90% X 80% = 360W. 
[bookmark: _Toc23371580][bookmark: _Toc29348][bookmark: _Toc41576620]3.12.3 DXF Layer Mapping 
In [image: ]drop down menu listed more options for layer operations. When there are more than one layers in DXF drawing, click [image: ]can appoint DXF layer to CypOne layer of cutting technique. Like below image, DXF layer appointed to CypOne layer for different technique. 
[image: ][image: ]

[bookmark: _Toc498088455][bookmark: _Toc530990227][bookmark: _Toc23371581][bookmark: _Toc19302]Nesting 
[image: ]Nesting is to arrange parts geometries in plate with highest utility with benefits of reducing waste and optimizing tool path. CypOne simplify the process to allow nesting complete by a few clicks. 
[bookmark: _Toc23371582][bookmark: _Toc26175][bookmark: _Toc41576621]3.13.1 Nest 
Import part drawing and select the objects, click [image: ]open dialog box setup plate size, margin and part gap will complete nesting. 
[image: ]
'Parts gap' is the minimum space between parts; 'Plate margin' is the empty space left on plate border. 
After nested parts, there will be a nesting list on left side where lists both drawing design and nesting results. 
CypOne supports up to 100 parts and 20 plate nesting. 
[bookmark: _Toc498088468][bookmark: _Toc530990231][bookmark: _Toc23371583][bookmark: _Toc17157][bookmark: _Toc41576622]3.13.2 Sort and Tool Path 
In Home > Sort listed function buttons for sort and align parts geometries: 
[image: ]
Related content on sort please refer to 'Group' section. If no special sorting requirements it's recommended just select 'Grid Pattern'. 
[bookmark: _Toc23371584][bookmark: _Toc3759][bookmark: _Toc41576623]3.13.3 Sequence Preview 
Drag the progress bar or click [image: ] you can preview the machining sequence of the part geometries. Below picture shows the status of a part in previewing sequence: 
[image: ]
This process is interactive can be controlled freely, you can only check sequence in selected area back and forth. Click [image: ] under Home > View will display overall tool path sequence. 
[bookmark: _Toc23371585][bookmark: _Toc2034][bookmark: _Toc41576624]3.13.4 Manual Sort 
If you want to adjust parts sequence, select the objects then click from these four buttons: [image: ]
	First 
	[image: ]
	Selected figure put as the first. 

	Last 
	[image: ]
	Selected figure put as the last. 

	Forward 
	[image: ]
	Move selected figure forward one step in sequence. 

	Backward 
	[image: ]
	Move selected figure backward one step in sequence. 


After finish sorting, you can click [image: ] to check the sequence one by one. 
You can also click [image: ] on left tool bar enter 'manual sort mode' to set sequence one by one. The sequence number tags on each figure and tool path will change accordingly when you modify the sequence. Just click one figure then point next one will define the sequence between them. If you point wrong object in sorting, click on this wrong object again to cancel last command or right click > cancel. If you only want to change sequence between two objects, click one then drag a line to the other. As shown below. 
[image: ]
[bookmark: _Toc23371586][bookmark: _Toc16601][bookmark: _Toc41576625]3.13.5 Group Sort 
If you want sequence of some objects fixed and not to be changed, select the objects and 'Group' them. Other manual sort or auto sort process won't change the sequence inside group. Until all figures inside a group completed laser will move to next object outside the group. 
If you only want to change sequence of some of the objects not affecting others, you can also do it by group the objects. Change the sequence inside group by right click it and select 'Sort in group'. 
[image: ]

4. [bookmark: _Toc23371587][bookmark: _Toc15296][bookmark: _Toc41576626]Cutting Control 
CypOne integrates CAD and CAM in one, all CAD operations can finished on your laptop in office as well as cutting technique setting, then send file to machine for cutting. 

[bookmark: _Toc23371588][bookmark: _Toc530990236][bookmark: _Toc498088473][bookmark: _Toc24359][bookmark: _Toc41576627]Coordinate System 
The 'modeling coordinate' in designing part geometry is not relevant to machine, part zero marked by [image: ] on drawing board. The coordinate relation in drawing and machine bed illustrated below: 
[image: C:\Users\fscut\AppData\Local\Temp\SNAGHTML9fef9e.PNG]

Click [image: ] on control panel will display position relation between drawing and white frame which indicates the cutting area relative to machine bed. 
[bookmark: _Toc23371589][bookmark: _Toc498088474][bookmark: _Toc530990237][bookmark: _Toc27089][bookmark: _Toc41576628]4.1.1 Mechanic Coordinate 
Mechanic coordinate is a unique existence decided by mechanism and machine config. Coordinate created any time after return origin is consistent. If mechanic coordinate deviated, click [image: ]  in CNC tab to reset coordinate.   
The definition to coordinate in CypOne is same no matter what mechanism structure is. In CypOne definition, laser head moves right to workpiece is X+ direction, laser head moves back towards workpiece is Y+ direction. Hence the bottom right in workpiece located smallest coordinate value, the top right in workpiece located biggest coordinate value. 
[bookmark: _Toc23371590][bookmark: _Toc6051][bookmark: _Toc41576629]4.1.2 Software Coordinate 
[image: ]Mechanic coordinate is fixed, CypOne adopts software coordinate that facilitates the production. The direction of CypOne software coordinate same with mechanic coordinate, only zero point different. Software coordinate contains float coordinate and workpiece coordinate. 
You can select coordinate on top of the control panel, there listed 'float coordinate', nine 'workpiece coordinate' and one 'external coordinate'. 
Float coordinate used in small quantity parts production, laser will start cutting from where it stands. Execute 'Frame', 'Dry Run' or 'Start', part zero will be current position of laser head. 
User can appoint a zero point manually to each workpiece coordinate 1-9. Workpiece coordinate applied in large quantity production, sheet material of standard size will be placed same position on machine bed. Use workpiece coordinate can mark a fixed zero point that guarantee cutting starts from same position on sheet every time. 
[image: ]Click [image: ] at the very bottom to select display mechanic or software coordinate in CypOne, you can also specify zero point here. Select 'coordinate locating' locate the cutting head to the specified coordinate position. 
[bookmark: _Toc23371591][bookmark: _Toc24431][bookmark: _Toc41576630]4.1.3 Find Part Zero after Exception 
Situation 1 
If machining process stopped by the accident like gas or laser exception which doesn't affect coordinate system, click [image: ] can locate to part zero. 
Situation 2 
If accidents like power down or servo alarm stop the machining process and deviate the coordinate system, must execute return origin reset coordinate then click [image: ] locate to part zero. 

[bookmark: _Toc23371592][bookmark: _Toc9267][bookmark: _Toc41576631]Alarm 
CypOne monitors alarm signal and core components status, it will stop machining once received alarm signal or detected alarm condition and display alarm message in red color on top title bar. Most of the motion functions are disabled until alarm released. Please check the machine by alarm message, make sure alarm condition solved then start cutting. The alarm title shown as below: 
[image: ]
The 'Alarm' window at the bottom also displays the alarm message. After remove the alarm source the alarm in title bar will disappear but alarm message in alarm window all saved. Double click 'System' window can check all history records and software events. 
Besides alarm CypOne will detect other working condition and display warning, notice and message in different color in 'system' window. These message won't stop the machining but still suggest take notice of it and take precautions in advance. 
The alarm can be released automatically or manually. The following are the limitations to some alarms: 
· Disable servo motor when emergency stop alarm activated 
· Disable X/Y motion functions when BCS100 alarm detected (under this status, Z axis condition unknown, there are collision risks if X/Y move) 
· Disable XYZ motion function when emergency stop alarm activated (in complete stop status) 
· Z limit- alarm, disable dry run and jog. 

[bookmark: _Toc23371593][bookmark: _Toc4515][bookmark: _Toc41576632]Manual Test 
The manual control buttons on control panel listed below: 
[image: ]
The button [image: ] will turn to [image: ] once activated. Press [image: ] will turn on laser, release button turn off laser. For other buttons, click the button activate the function, click again close the function. For example, click [image: ] open the gas, click again close gas. For different laser model, there will be a delay click [image: ] till it turns to[image: ]. This status accessed from laser source. Click [image: ]will open guide/pilot laser beam. 
These buttons work with hardware on machine to function. If hardware damaged or not properly set configuration in machine config tool, button doesn't function. 
Click [image: ] to mark the current position, click [image: ] if you need to locate to the mark position. User can set 6 markers select from [image: ]. 

[bookmark: _Toc23371594][bookmark: _Toc530990242][bookmark: _Toc498088479][bookmark: _Toc9610][bookmark: _Toc41576633]Soft Limit Protection 
CypOne can limit machine travel range by software limit, click [image: ] on control panel will enable the function. 
When CypOne calculates the cutting zone of drawing will exceed travel range, it will prompt 'motion out of range' message and forbid sending motion command to avoid collision. Check the part zero setting and adjust laser head position. 
System will monitor the current position in real time and stop the motor function once detected laser exceeded soft limit range. 
Notice: soft limit protection relies on correct coordinates. Therefore, every time after change the machine config or system abnormal shut down happens, must execute return origin to reset coordinate. 

[bookmark: _Toc23371595][bookmark: _Toc530990243][bookmark: _Toc498088480][bookmark: _Toc26331][bookmark: _Toc41576634]Frame 
Click [image: ] laser head will run the outline of the cutting zone in a frame box. It helps to identify if the cutting will exceed plate. Frame speed set in Layer Parameter Window > Global Parameter > Frame Speed. 
Notice: If execute 'Find Edge' process before frame, CypOne will offset coordinate with the angle of plate, frame path also runs in a angled box rather than square box. 

[bookmark: _Toc23371596][bookmark: _Toc530990244][bookmark: _Toc498088481][bookmark: _Toc14024][bookmark: _Toc41576635]Start and Dry Run 
Click [image: ] on control panel start cutting, the working status bar will display on top monitoring coordinate, speed, time and follow distance etc. 
[image: ]

The working status bar cannot switch to others during a cutting task in case any operations change the part drawing. If you need change parameter please pause the cutting first then open layer parameter window modify the parameter.
Click [image: ] machine will run the tool path not turning on laser and gas, while the speed and path are same with actual cutting. In dry run you can also execute pause, resume, forward, backward and even locate break point, all same with real cutting process. Dry run used to fully check and simulate the whole cutting process. 
You can choose to enable [image: ]in Layer > global parameter window.
[image: ]By default laser will go to zero point after cutting finished, if you want laser goes to other position after cutting you can select in control panel  [image: ] , options including part zero, start position, end position, origin and marker. If [image: ] not selected, laser head will stand where the cutting finished which equals to 'end position'. If you use 'float coordinate', it's recommended to choose laser goes to 'zero point' after cutting. 
After finish the cutting of one drawing, the counter on control panel will add up 1, when reach the planned cutting times of one drawing will prompt message dialog box to notice user. Click [image: ] open dialog box setup the production schedule and auto pause. For loop cutting task, click [image: ] to finish setup. 

[bookmark: _Toc23371597][bookmark: _Toc530990245][bookmark: _Toc498088482][bookmark: _Toc10903][bookmark: _Toc41576636]Stop, Pause and Resume 
Click [image: ] or [image: ] on control panel to stop a cutting task. Laser head will stand at where it stopped. 
Click [image: ] or [image: ] on control panel to pause a cutting task. It's allowed to change some of the cutting parameters in layer window, or you can execute manual functions in control panel like burst laser and gas blow. 
Click [image: ] on control panel will resume the cutting from paused position. Click [image: ] will skip pierce process and cutting from paused position directly. 
Click [image: ] or [image: ] laser head will step forward or backward along the tool path, the step distance set in [image: ] on control panel. 

[bookmark: _Toc530990246][bookmark: _Toc23371598][bookmark: _Toc498088483][bookmark: _Toc1751][bookmark: _Toc41576637]Breakpoint 
When cutting process stopped or interrupted by accidents, as long as not changing any cutting parameters, you can click [image: ] locate to break point. Click [image: ]locate to break point and resume cutting. 
If you change the cutting parameter of stopped/interrupted cutting process, the '[image: ]will change to [image: ] which means resume from breakpoint is not available. 

[bookmark: _Toc498088484][bookmark: _Toc530990247][bookmark: _Toc23371599][bookmark: _Toc25531][bookmark: _Toc41576638]Start from Given Position 
CypOne allows user starts cutting from given position of drawing. Right click on drawing, select 'start from here'. Shown in picture: 
[image: ]
For safety concern, select ' ', program will prompt dialog box asks users to confirm operation again. Then laser head will locate to the specified position start cutting. 
If select ' locate here', laser head will locate and pause at given position. 
You can execute 'locate here ' multiple times to confirm location is right. Or you can adjust start position more precisely by [image: ]  and [image: ]. 

[bookmark: _Toc498088485][bookmark: _Toc530990248][bookmark: _Toc23371600][bookmark: _Toc28177][bookmark: _Toc41576639]Global Parameter 
The parameters setting in 'Global Parameter' window will affect the machine running condition, workpiece cutting performance and efficiency. 
	① Motion control parameters 

	X,Y traverse speed 
	Traverse speed is the rate at which machine positioning in between cuts (different with cut speed0. 

	Traverse acceleration 
	The maximum traverse acceleration in traverse movements. 

	Frame speed 
	Speed when laser head execute Frame function. 

	Cut acceleration 
	The acceleration in cutting. 

	LFP(Low-pass filter) 
	The rate that cut acceleration changes with respect to time. 

	Default settings 

	Burst pulse frequency 
	PWM pulse frequency when burst laser via CypOne control panel. 

	Burst peak power 
	The peak power when burst laser. 

	Manual gas blow 
	The gas pressure when click Blow in CypOne panel. 

	Gas on delay 
	Delay to gas on in default PLC process. 

	First gas on delay 
	Extra delay added to gas on delay when start cutting and execute gas blow the first time. 

	Switch gas delay 
	The time required to make sure old gas totally discharged and new gas comes in to channel when switch the gas. 

	Back when resume 
	When resume the paused cutting, laser head will move backward a distance then start cutting. 

	② Follow parameter 

	Max follow distance 
	There is an effective capacitance sensing range, which means follow distance in this range is accurate. If follow distance larger than this value, laser will follow to this limit distance first then lift up to target distance. 

	Frog-leap lift 
	Laser head will lift up to given height then travel to next when finish cutting of one tool path segment, this function can optimize lift action to reduce the travel time needed. 

	Follow in dry run 
	By default, laser head doesn't follow to plate in dry run. Select this option if you need laser head follow to plate in dry run. 

	Disable follow 
	In a standard cutting, laser head tip will follow to plate surface and maintain a constant distance. If you need laser head cutting in fixed height not follow to plate surface just select this option. 

	Shelter alarm in pierce 
	Shelter the capacitance alarm in piercing. 

	Hold at fixed height 
	This option used in non-metal cutting, laser cutting in a given height above plate surface rather than follow and maintain a constant distance. 

	Unlift when travel shorter than 
	When laser finished one segment tool path cutting, it lifts up then travel to next tool path segment. If the travel distance shorter than this value, it doesn't lift up and keeps follow to next tool path segment. 

	Unit selection 
	Select the unit system by user’s habits. 

	③Advanced 

	NURBS interpolation 
	Select the option CypOne will optimize tool path smoothness by nurbs fitting. 

	Compensate precision 
	Precision of kerf width compensation. 

	Fly Cut overcut 
	Add an extra distance to the end of the fly cut tool path, make sure parts fully cut off in high speed cutting. 

	Auto group pre-pierce 
	By default laser will execute piercing to grouped figures, then to others. If no group in drawing, laser will finish piercing of all figures then start cutting. Select this option, laser will execute both piercing and cutting of one part geometry then locate to next part. 


5. [bookmark: _Toc23371601][bookmark: _Toc19001][bookmark: _Toc41576640]CNC Assist Function 
[bookmark: _Toc530990250][bookmark: _Toc498088487][bookmark: _Toc23371602][bookmark: _Toc27058][bookmark: _Toc41576641]Simulate Process 
User can simulate whole cutting sequence in software after finish nesting and sorting of part geometries. This operation doesn't require machine tool involved. By simulating you can see part to part cutting sequence and in-part cutting sequence. 
Click [image: ] in control panel, it will switch to 'CNC' tab automatically, you can adjust simulating speed in tool bar. 
[image: ]

[bookmark: _Toc23371603][bookmark: _Toc16169][bookmark: _Toc41576642]Find Edge 
CypOne allows user manually locate plate edge by targeting 2 points on plate border. 
[image: ]

Choose one side of plate, then locate laser head to P1 and P2 position save the setting, software will calculate the plate placement angle and offset into coordinate automatically. 

[bookmark: _Toc530990255][bookmark: _Toc23371604][bookmark: _Toc498088491][bookmark: _Toc29717][bookmark: _Toc41576643]PLC Process 
Click [image: ] in CNC tab open PLC editor, you can customize and execute PLC process. 
Notice: improper PLC settings will cause severe consequence! 

[bookmark: _Toc498088492][bookmark: _Toc530990256][bookmark: _Toc23371605][bookmark: _Toc652][bookmark: _Toc41576644]Return Origin 
Click [image: ] in CNC tab will return motor axes to mechanic origin and reset coordinate. Or return single axis return origin by options under ‘Return Origin’ drop down menu by select [image: ] and[image: ]. When click [image: ] will return laser head (Z axis) first, then follows X and Y.

[bookmark: _Toc498088496][bookmark: _Toc530990260][bookmark: _Toc23371606][bookmark: _Toc10212][bookmark: _Toc41576645]Diagnosis Tools 
You can open Main I/O monitor in [image: ] in File menu during a cutting to check status of functioning parts involved.   
[image: ]
In left zone displays each motor axis number and pulse feedback from encoder. User can send given pulse commands to single axis motor check if pulse equivalent set right. Limit monitors if laser hits the limit sensor. PWM monitors laser status of turning on/off. It also monitors active status of 6 input ports and 8 output ports. 

[bookmark: _Toc498088497][bookmark: _Toc530990261][bookmark: _Toc23371607][bookmark: _Toc41576646][bookmark: _Toc31827]BCS100 
Click [image: ] in File menu open the BCS100 control panel where you can execute return origin, follow, locate and calibration etc. 

[bookmark: _Toc23371608][bookmark: _Toc530990263][bookmark: _Toc498088499][bookmark: _Toc19860][bookmark: _Toc41576647]Error Measure 
Click [image: ] laser will dry run along the tool path. CypOne will display motor path in blue color with command path as comparison, by which you can adjust motor and cutting parameters.
6. [bookmark: _Toc23371609][bookmark: _Toc23129][image: ]Appendix 
[bookmark: _Toc23371610][bookmark: _Toc11745][bookmark: _Toc41576648]Co-edge Example 
Below is the co-edge example. On right side is original design of DXF file. 
Open figure highlight in red color which also the lines to merge as common line. 
There are 6 bigger parts and 10 long strip parts down below, and 9*2=18 short strip parts at right side. 
First, separate these 3 parts from original design. As below: 
[image: ]
[image: ]Select all shapes of one part then group them. 
[image: ]
Select this part then create a 3*2 size array. 
Select 6 parts in array, click [image: ] will merge as common line design. 
Then drag part 2 close to part 1, it will snap to key point. As below: 
[image: ]
Select part 2, create a 2*9 size array. Select all 18 part 2, drag from left to right can avoid part 1. 
[image: ][image: ]
Click [image: ] will merge all part 2 as common line. You have to take notice here that cutting has to start from right to left, otherwise the plate in this area will deviate or vibrate because lack of support from plate skeleton. 
Right click part 2 select ‘Sort in group’ > ‘Right to left’. 
Next we will co-edge part 3. 
Select part 3 create 10*1 size array. 
[image: ]
Select all part 3 then click [image: ] will merge as common line. As shown below. Take notice that outline of common line part is thicker. You can see the border of three common line design are thicker than lines of shapes inside. 
When the cursor point on the part design it will show the message indicates it's a group. 
[image: ]
By same principle part 3 should be cut from top to bottom. 
Drag part 3 close to bottom of part 1 then snap on border. As below: 
[image: ]
If you want to co-edge all par 1, part 2 and part 3, just select all and click[image: ]. 
If you don't need all parts co-edge then skip this step. You also need to drag part1/2/3 away each other’s border. 
Click space button will turn off snap function temporarily. Snap will function in next operation. 

[bookmark: _Toc23371611][bookmark: _Toc530990281][bookmark: _Toc4979][bookmark: _Toc41576649]Regional Output(Dust Collection) 
In CypOne config tool > regional output where you can setup signal ports for dust collector. Check [image: ] you can setup rows and columns to divide regions by your dust collector location. Drag the border line to adjust regions. Or you can precisely input border coordinate. When machine located to one region in cutting, output of this region will activate then dust collector works to extract polluted fumes. 
[image: ]

[bookmark: _Toc23371612][bookmark: _Toc6449][bookmark: _Toc530990283][bookmark: _Toc422327110][bookmark: _Toc498088518][bookmark: _Toc41576650]Motion Parameter Adjustment 
[bookmark: _Toc23371613][bookmark: _Toc8134][bookmark: _Toc41576651]6.3.1 Motion Parameter Specification 
The motion parameters including speed, acceleration, low pass filter and corner/curve precision are available to adjust parametrically. The parameter description listed in below table: 

	Parameter 
	Description 

	X,Y traverse speed 
	The maximum travel speed. 

	Traverse acceleration 
	The maximum travel acceleration. 

	Cut acceleration 
	Maximum cutting acceleration, which also decides acceleration in corner cutting. You have to observe the torque curve in servo tool to adjust this parameter. 

	LFP(Low-pass filter) 
	Filter the noise to suppress machine vibration. Lower value means stronger effect but it also lengthen the acceleration time. 

	Curve precision 
	The maximum curve precision of cutting control. The lower the value is, more obvious in speed limit at curve cutting. 

	Corner precision 
	The precision of corner precision in NURBS curve fitting. The lower the value is, corner path will be sharper and speed reduction more obvious. 


[bookmark: _Toc23371614][bookmark: _Toc530990284][bookmark: _Toc498088519][bookmark: _Toc422327111][bookmark: _Toc21253][bookmark: _Toc41576652]6.3.2 Cutting Acceleration 
Jog motor axis in high speed like 500mm/s. 
Monitor the torque curve in servo tool when jog the axis, increase the work acceleration if peak torque under 80% or reduce cut acceleration if peak torque larger than 80%. 
Adjust the acceleration until peak torque reaches to 80%. The acceleration lead screw structure can bear is usually no more than 0.5G. And no more than 2G for rack gear structure. 
[bookmark: _Toc422327112][bookmark: _Toc498088520][bookmark: _Toc23371615][bookmark: _Toc530990285][bookmark: _Toc30977][bookmark: _Toc41576653]6.3.3 Traverse Acceleration 
You can put this value calculated by Servo Tools. Or larger than cut acceleration by 1.5~2 times. The peak torque of servo motor in dry run cannot exceed 150%, within this range the mechanism can stand the impact, distortion and noise. The acceleration lead screw structure can bear usually no more than 0.5G. And no more than 2G for rack gear structure. 
[bookmark: _Toc23371616][bookmark: _Toc422327113][bookmark: _Toc498088521][bookmark: _Toc530990286][bookmark: _Toc18903][bookmark: _Toc41576654]6.3.4 Low-Pass Filter 
Adjust low pass filter by cutting a workpiece sample. Lower laser power burns marking on workpiece. Observe and measure the accuracy of the marking path. Marking path can be shapes of circle, star, polygon and square of different size. As shown in the following figure: 
[image: ]
Lower the low pass filter as much as possible within desirable cutting precision. The indication is no waving at corner cutting. You can directly setup the parameter by the below table. Or you can adjust and determine the cut acceleration, then adjust low pass frequency around 2 levels around it. Cut acceleration must match with low pass filter, one of them cannot be impressively large than the other. 
	Level 
	1 
	2 
	3 
	4 
	5 
	6 
	7 
	8 
	9 
	110 

	Cut Acceleration (G) 
	0.1 
	0.2 
	0.3 
	0.4 
	0.5 
	0.6 
	0.8 
	1 
	1.5 
	2 

	Low pass filter (HZ) 
	3 
	3.5 
	4 
	5 
	5.5 
	6 
	6 
	6 
	7 
	88


[bookmark: _Toc23371617][bookmark: _Toc530990287][bookmark: _Toc422327114][bookmark: _Toc498088522][bookmark: _Toc18730][bookmark: _Toc41576655]6.3.5 Curve & Corner Precision 
Only under special circumstances to adjust the parameters in a small extent around the default value, otherwise not recommend to modify these two parameters. 
If the curve precision of cutting not good, you can lower the curve precision which will limit the cutting speed at curve path. If the corner precision of cutting is not good, lower the corner precision will limit the cutting speed at sharp corner. The value set too large the sharp corner will turn to a round corner. 

[bookmark: _Toc23371618][bookmark: _Toc1822][bookmark: _Toc41576656]Shortcut Keys 
The table lists the shortcut keys in CypOne for some common operations. 
	Shortcut Keys 
	Effect 
	Using conditions 

	Ctrl + A 
	Select all
	None 

	Ctrl + C 
	Copy objects to clipboard
	Select the objects 

	Ctrl + Shift + C 
	Copy with basepoint
	Select the objects 

	Ctrl + O 
	Open file
	None 

	Ctrl + V 
	Paste copied objects to drawing board
	Copied objects 

	Ctrl + X 
	Cut objects to clipboard
	Select the objects 

	Ctrl + Y 
	Redo the command just revoked
	There are revoked commands 

	Ctrl + Z 
	Revoke the command just completed
	There are completed commands 

	F2 
	Open layer cutting parameter setup window 
	None 

	F3 
	Display all drawing in the center screen 
	None 

	F4 
	Display all drawing in the center white box 
	None 

	F7 
	Display/hide tool path 
	None 

	F8 
	Display/hide position path 
	None 

	DEL (delete) 
	Delete selected drawing 
	Select the objects 

	SPACE 
	Repeat previous command 
	The command is repeatable 


[bookmark: _GoBack]
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